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~ PUBLIC NOTICE

FEDERAL COMMUNICATIONS COMMISSION News Media Information: (202) 418-0500
445 12th STREET, S.W. Fax-On-Demand: (202) 418-2830
WASHINGTON, D.C. 20554 Internet: http://www.fcc.gov
ftp.fcc.gov
DA 00-1460
June 29, 2000

AUCTION OF A NEW TELEVISION STATION
CONSTRUCTION PERMIT, CHANNEL 52
AT BLANCO, TEXAS

11 Qualified Bidders

Report No. AUC-80-C (Auction No. 80)

This Public Notice identifies 11 applicants that have been found qudified to bid in the auction
for anew televison gation congtruction permit for Channd 52 at Blanco, Texas (“Auction No.
80"), which is scheduled to begin on Wednesday, July 12, 2000. This Public Notice also
contains bidding instructions and other important information regarding the auction.

Attachment A lists each of the 11 qudified bidders, their upfront payments, and maximum
digibility in bidding units.

Attachment B lists those applicants that submitted short-form gpplications (FCC Form 175),
but did not qudify to bid in this auction.

Attachment C contains software downloading/ingaling instructions for participation in the
mock auction.

Attachment D provides information on “How to Monitor FCC Auctions Onlineg’ and round
results file formats for use during the auction.

Attachment E provides information concerning Accessing the FCC Network using Windows
95/98.

In order to participate effectively in the auction, qudified bidders should re-familiarize
themsdlves with the auction rules and other information contained in the Public Notices released



for this auction.” The following information provides additional guidance.

Registration. Qualified bidders have been automaticaly registered for the auction. For
security reasons, the Commission will confirm registration by two separate mailings of
registration materias, both sent to the contact person at the contact address identified in the
bidder's FCC Form 175. Each mailing will include confidentia bidding codes. The second
mailing will aso include remote bidding system software, if ordered. Upon receipt of both
mailings, each bidder should be in possession of the following information:

FCC Account Number (as assigned by FCC)

Bidder Identification Number

LoginID

Login Password

Remote bidding system software and instruction booklet (if purchased)
FCC Bidder Line Telephone Number

Applicants are solely responsible for ensuring the security of their computer systems,
the security of their bidding codes, and that only authorized bidders place bids on their
behalf. The FCC assumes no responsibility or liability for these matters.

WARNING: Any unauthorized person or entity accessing or tampering with an FCC
or other gover nment computer will be prosecuted to the full extent of the law.

Any applicant listed as a quaified bidder in Attachment A to this Public Notice that has not
received both regigtration mailings by noon on Friday, July 7, 2000, must contact the
Auctions Hotline directly at (717) 338-2888. It is each gpplicant's respongbility to ensure that
al regidration information has been received. Note: The bidding software mailed via Federd
Expressis not the software used in the mock auction, and is specifically designed to only be
used in the actud auction event. The downloadable mock auction software is discussed later in
this public notice.

Bidding Code Replacement. Lost Login IDs, Login Passwords and Bidder Identification
Numbers can be replaced only at the FCC Auction Headquarters, located at 445 12" Strest,
SW., Washington, D.C. If replacement is necessary, ether an authorized representative or the
certifying officia (as designated on the applicant's FCC Form 175) must gppear in person with
two forms of identification, one of which must be a photo identification. The authorized
representative should immediately contact the technica support hotline to arrange the
replacement of bidding codes.

Electronic Bidding Software. Only those qudified bidders that have purchased the
Commission's dectronic bidding software will be permitted to bid eectronicaly. The software
has been updated for Auction No. 80; therefore, software from prior auctionswill not work

! See “Auction Notice and Filing Reguirements for aNew Television Station Construction Permit,

Channel 52 at Blanco, Texas; Auction Scheduled for July 12, 2000; Minimum Opening Bid and Other
Procedural Issues,” Public Notice, DA 00-1226 (released June 5, 2000) (“ Auction No. 80 Public Notice”).
This and other documentsreleated to Auction No. 80 are available on the Commission’s Auctionwebsite at:
http://www.fce.goviwtb/auctions.



for thisauction. For software backup, bidders are advised to duplicate the software for use
by its authorized bidders at different locations. However, the FCC Remote Bidding Software
will not accept eectronic bids from qudified bidders who have not purchased the bidding
software.

Bidding Contingency Plan. Bidders should develop comprehensive contingency plansthey
can implement quickly in case they experience difficulty participating in the auction. While the
FCC will correct any problems within Commission-controlled facilities, bidders are solely
respongble for anticipating and overcoming problems such as bidder technica failures, loca
telephone service interruptions, adverse locd weather conditions, unavailability of authorized
bidders, or loss or breach of confidentia security codes.

The FCC Remote Bidding System requires access to a 900 service telephone line. Bidders
should verify in advance that the telephone systems they will be using to submit dectronic bids
permit access to 900 service telegphone numbers, and should consult their telephone
adminigrators if they need assistance.

All qudified bidders will be supplied with a telephone number for telephonic bidding in their
registration materids. Those choosing not to bid eectronicaly are required to use this telephone
number to place bids. Electronic bidders may use this telephone number as an aternate method
of bidding in the event they are not able to submit their bids eectronicaly.

Minimum Opening Bids. Therewill be aminimum opening bid of $420,000 for the
congtruction permit in Auction No. 80, caculated in accordance with the formulas we have
previously announced.” The minimum opening bid amount is subject to reduction a the
discretion of the Commission. Bidders should be aware, however, that the FCC will not
entertain requests to lower the minimum opening bid. The agency will exerciseits discretion, if
at dl, independent of any communications from bidders.

Messages and Announcements. The FCC will post pertinent auction informéation as
messages and announcements on the FCC Remote Bidding System and on its Internet Site.
Bidders should routinely check for messages and announcements each time they enter the
Remote Bidding Systemn, and should read this informetion carefully.

2 See Auction No. 80 Public Notice at 15-16.



Bidding Schedule. The bidding schedule for Wednesday, July 12, 2000, will be:

Bidding Period 9:00 am. - 9:30am. ET
Round Results 9:30am. - 9:45am. ET
Bidding Period 11:00 am. - 11:30am. ET
Round Results 11:30 am. - 11:45am. ET
Bidding Period 2:00 p.m. - 230 p.m. ET
Round Results 2:30 p.m. - 245p.m. ET
Bidding Period 4:00 p.m. - 4:30 p.m. ET
Round Results 4:30 p.m. - 4:45p.m. ET

The bidding schedule for Thursday, July 13, 2000, and continuing until further notice, will be:

Bidding Period 9:00 am. - 9:30am. ET
Round Results 9:30 am. - 945am. ET
Bidding Period 10:00 am. - 10:30am. ET
Round Results 10:30 am. - 10:45am. ET
Bidding Period 11:.00 am. - 11:30am. ET
Round Results 11:30 am. - 11:45am. ET
Bidding Period 2:00 p.m. - 230 p.m. ET
Round Results 2:30 p.m. - 2:45p.m. ET
Bidding Period 3:00 p.m. - 330 p.m. ET
Round Results 3:30 p.m. - 345p.m. ET
Bidding Period 4:00 p.m. - 4:30 p.m. ET
Round Results 4:30 p.m. - 4:45p.m. ET

The FCC will st the pace of the auction based upon its monitoring of the bidding and its
assessment of the auction's progress. All schedule changes are made by announcement during
the course of the auction.

Bidder Questions during the Auction. FCC auction officias and technica support staff will
be available during the course of the auction to answer questions from authorized bidders.
Bidders should identify themselves as a bidder with time sengtive auction questions when calling
any number. Help can be obtained through the following telephone numbers.

FCC Bidder Line
(telephonic bidding, auction conduct
questions)

Use telephonic bid number
supplied in regigration mailing



FCC Technica Support Hotline (202) 414-1250
(al technicd quedtions, software and
hardware)

FCC Auctions Divison (legd questions) (202) 418-0660

Monitoring Round Results. Attachment D (How to Monitor FCC Auctions On-Line) of this
Public Notice provides ingructions for reviewing and downloading round results, and other
materid related to Auction No. 80 released by the Commission during the course of the auction.

Amendmentsto FCC Form 175s. Applicants are respongble for maintaining the accuracy
and completeness of information furnished in their FCC Form 175 and exhibits. See 47 C.F.R 8§
1.65. Itisthe daff's position that gpplicants should amend their applications within ten business
days from the occurrence of areportable change. Filers should make modifications to their
FCC Form 175s dectronicdly, and submit aletter briefly summarizing the changes to:

Amy Zodov
Chief, Auctions & Industry Andysis Divison
Wirdess Tdecommunications Bureau
Federd Communications Commission
Room 4-A760
445 12" Street, SW
Washington, DC 20554

with a courtesy copy to Kenneth Burnley at the same address in Room 4-B524. As described
in the Commission's Rules, gpplicants may make only minor corrections to their FCC Form 175
goplications (e.g., mailing address, fax number, authorized bidder). Mgor modifications (e.g.,
changing control of the applicant, changing the certifying officid) will not be accepted. See 47
C.F.R. § 1.2105(b).

Due Diligence. Thewinning bidder in the auction for anew congtruction permit for the new
full power television gation on Channel 52 a Blanco, Texas, upon submission of itslong-form
gpplication (FCC Form 301), will have to provide interference protection to qudified Class A
televison gtations. Therefore, potentid bidders are encouraged to perform engineering studies to
determine the existence of Class A televison stations and their effect on the ability to operate a
full power television station on Channel 52 a Blanco, Texas.”

Bidders are reminded that they should continue to conduct their own research prior to Auction
No. 80 in order to determine the existence of pending proceedings that might affect their
decisons regarding participation in the auction.

Mock Auction. The FCC will conduct a mock auction on Monday, July 10, 2000, to alow
qudified bidders to familiarize themsealves with the dectronic bidding software. The mock

3 See Auction No. 80 Public Notice at 5. See also Establishment of a Class A Television Service,

MM Docket No. 00-10, Report and Order, FCC 00-115 (rel. April 4, 2000) (“ Class A Report and Order™).



auction will be open only to qudified bidders. Telephonic bidding will aso be available during
the mock auction. Qudified bidders wishing to place telephonic bids should use the telephone
number supplied in the regisiration materids for the auction. Pre-registration is not required to
participate in the mock auction.

This mock auction will follow the rules governing the actud auction. The mock auction will be
identified as Auction No. 74. The software will reflect the congtruction permit and the
associated $420,000 upfront payment, which in turn corresponds to 420,000 bidding units.
The mock auction will amulate the start of the auction and al bidders will be required to be
active on 100 percent of their bidding units, or risk having awaiver automaticaly gpplied. If
there are no activity rule waivers available, the bidder' s digibility will be reduced, diminating
them from the auction.

Electronic bidders participating in the mock auction are advised to review the software manua
provided in the second mailing. For ingtdlation ingtructions, please refer to Attachment C of this
Public Notice.

The mock auction bidding schedule for Monday, July 10, 2000 will be:

Bidding Period 9:.00am.- 9:30am.ET
Round Results 9:30am.- 945am. ET
Bidding Period 11:00 am. - 11:30 am. ET
Round Results 11:30 am. - 11:45am. ET
Bidding Period 2:00 p.m.- 2:30 p.m. ET

Round Results 230p.m.- 2:45p.m. ET
Bidding Period 4:00p.m.- 430 p.m. ET
Round Results 4:30 p.m. - 4:45p.m. ET

Eligible Auction No. 80 bidders who wish to participate in the mock auction using eectronic
bidding must establish a Point-to-Point Protocol (PPP) connection to the FCC Auction
Network through either an 800 or a 900 number, as salected through the mock auction
software. (The FCC strongly encourages participants to test their ability to connect using the
900 number, in order to identify any potentia problems such as a 900-number tel ephone block.
There will be no access charge for the first minute of the 900-number connection time,)

When participants establish the PPP connection and start the Mock Bidding System, they will
register for the mock auction by entering their FCC Account Number. The Login name, Login
password, and Bidder Identification Number (BINS) will be prefilled. Note: Pre-filled codes
are used for the mock auction only. For the actud auction, bidders must enter the confidentia
bidding codes supplied in the overnight mailings in order to access the bidding software.

Remote bidding software for the mock auction will be available via the FCC's Internet System
by noon on Friday, July 7, 2000. See Attachment C for downloading/ingdling instructions.
This software is specificaly designed for this smulation, and is not adaptable to any other FCC
gpectrum auction. As part of the software, the Commission has established a suggestion box



and welcomes your comments regarding the software.
OTHER IMPORTANT INFORMATION

Long-Form Applications: Applicants that claim new entrant status should be aware that a the
long-form gpplication stage they will be subject to the more extengve reporting requirements
contained in the Commission's Part 1 ownership disclosurerule. See 47 C.F.R. § 1.2112(b).

For additiond information regarding this Public Notice, please contact Lisa Stover or Bob
Reagle, Auctions and Industry Anays's Divison, Wireless Telecommunications

Bureau, at (717) 338-2888, or Kenneth Burnley, Auctions and Industry Analysis Divison,
Wireless Telecommunications Bureau, at (202) 418-0660. Questions about software or
hardware should be directed to Technica Support at (202) 414-1250.

- FCC-



FCC Channel 52 Blanco, Texas Auction
Auction ID:80

Qualified Bidders - Public Notice

(Sorted by Applicant)
Date of Report: 6/28/00
The following Applicants have been found 'Qualified" :

ATTACHMENT A
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FCC Account # Name

Upfront Payment

Maximum Eligibility

(Bid - Units)
2000095612 Aaron Communications, L.P. $420,000.00 420,000
2000114840 Alliance Trust $420,000.00 420,000
2000180847 Blanco Television, LLC $420,000.00 420,000
2000153547 Blue Mountain Communications, Inc. $420,000.00 420,000
2000112943 ComCorp Broadcasting, Inc. $420,000.00 420,000
2000145457 Douglas Johnson $420,000.00 420,000
2000112016 Pappas Telecasting of El Paso-Juarez $420,000.00 420,000
2000112618 Pegasus Broadcast Television, Inc. $420,000.00 420,000
2000154547 Post-Newsweek Stations, Inc. $420,000.00 420,000
2000172606 S L Communications, Inc. $420,000.00 420,000
2000123701 Univision Television Group, Inc. $420,000.00 420,000
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FCC Channel 52 Blanco, Texas Auction
Non-Qualified Bidders

Auction ID: 80

(Sorted by Applicant)
Date of Report: 6/28/00

ATTACHMENT B

FCC Account # Name

2000003451 BK Radio

2000162115 Channel 52, LLC

2000182234 Christian Television Media, Inc.
2000183246 Council Tree Communications, L.L.C.
2000144046 Elgin FM Limited Partnership
2000162318 George S. Flinn, Jr.

2000090206 James L. Oyster

2000193749 KT Broadcasting, Inc.

2000143537 Mountain Communications, Inc.
2000155133 Rodriguez Communications, L.L.C.
2000120144 Star Broadcasting, Inc.
2000142650 Venture Technologies Group LLC
2000131115 WF Broadcasting, LLC

Page 1 of 1



I. ATTACHMENTC

PARTICIPATING IN THE FCC MOCK AUCTION

This attachment describes how to download and ingtdl the FCC Mock Bidding Software for quaified
bidders who wish to participate in the FCC Mock Auction. It also describes how to monitor the Mock
Auction.

Conventions
Theingructionsin this section use the following typographica conventions:

bold Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions link,
Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Location fidd, Selected Licenses
area of ascreen).

bolditalic  Represents charactersthat you must type exactly asthey appear in the ingtructions. For
example, if you are ingructed to type http: //wtbwwwO1.fcc.gov, you should type dl of
the characters shown in bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note: Throughout these ingructions, “enter” means to type the gppropriate information and then press
the ENTER key.

A. Minimum Hardware and Softwar e Requirements

Quadlified bidders who want to participate in the FCC Mock Auction will need, a a minimum, the
following hardware and software:

1. Hardware Requirements

CPU: Inted® Pentium

RAM: 16 MB (more recommended if you have multiple gpplications open)
Hard Disk: 33 MB available disk space

Modem: 28.8 Kbps Hayes© compatible mode (recommend 56.6 Kbps)
Monitor: VGA or above

Mouse or other pointing device
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2. Software Requirements

Microsoft® Windows 95™ or 98™

FCC Mock Bidding Software, available through the Internet

Netscape® Communicator™ 4.73 is recommended. However, you can also use Netscape
Communicator 4.5, 4.51, 4.61, 4.7, or 4.72 (Internet web browser software).

Note: To download Netscape Communicator 4.73 free of charge, access the Netscape
download ste at http://home.netscape.com/downl oad/

Note: The FCC Mock Bidding Software has not been tested in a Macintosh, OS/2, or Windows

NT™ environment. Therefore, the FCC will not support operating systems other than Microsoft
Windows 95 or 98. Thisincludes any other emulated Windows environment.

B. Downloading the FCC Mock Bidding Software

FCC Mock Auction participants must first download the FCC Mock Bidding Software from the
Internet. Participants must download the mock80.exe compressed file to ingtal the software.

Y ou may use your Web browser to download the compressed files from wtbwwwO1.fcc.gov,
wtbwww13.fcc.gov, or www.fcc.gov/wtb/auctions/, as described in the following section.

1. Downloading from wtbwwwO01.fcc.gov or wtbwwwl3.fcc.gov

1. Connect to your Internet service provider and start your Web browser.
2. Enter thefollowing location: wtbwwwO1.fcc.gov or wtbwwwi3.fcc.gov
3. Click M ock

4. Click Programs

5. Download the following file mock80.exe

2. Downloading from www.fcc.gov/wtb/auctions/

1. Connect to your Internet service provider and start your Web browser.
2. Enter thefollowing location: http://www.fcc.gov/iwtb/auctions/
3. Inthe Auctions section to the right, click Blanco Texas Broadcast (#80) under Future Auctions

4. Click Mock Auction Software
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5. Download the following file mock80.exe

C. Extracting and Installing the FCC Mock Bidding Software

The FCC Mock Bidding Software file is downloaded in a sdf-extracting, compressed file format.
Before ingtdling the FCC Mock Bidding Software for Auction 80, you must uninstall any mock or
remote bidding softwar e that wasinstalled on your computer before Auction 80.

After you have downloaded the compressed file for the FCC Mock Bidding Software, you must extract
the software from that file. To extract the software, follow these seps.

1. Start Windows Explorer and open the file folder where you downloaded the files.
2. Double-click mock80.exe.

3. Follow theindructions that display on your screen.

4. At the system prompt to reboot, leave Y es (the default) sdlected and click Finish.

After the FCC Mock Bidding Software has been ingalled, you will have anew Program group called
FCC Remote Bidding System with an M ock 80 Bidding Softwar e option in the drop down list. You
will also see two icons on your desktop, labeled M ock 80 Bidding Software and M ock 80 Dial-Up
Connection.

D. Connecting To the FCC Network

Before running the FCC Mock Bidding Software, you must connect to the FCC Network viathe FCC
Auctions 800#. For details about connecting to the FCC Network, refer to the attachment titled
Accessing the FCC Network Using Windows 95/98.

E. Starting the Mock Bidding Software

Y ou may start the FCC Mock Bidding Software by double-clicking the M ock 80 Bidding Software
icon on your desktop.

Note: Although thisis Auction 80 (Blanco, Texas), the auction 1D used in the Mock Auctionis 74.

F. Tracking the FCC Mock Auction

Mock Auction round results and announcement files will be posted on the FCC Internet in the same
location as the auction results. The directory structure for the mock auction will be as follows:

On the primary location, wtbwwwO1l.fcc.gov:

http://wtbwwwOL.fcc.gov/M ock/Results/dbf/
C3



http://wtbwwwO1.fcc.gov/M ock/Resultsmdb/
http://wtbwwwOL1.fcc.gov/Mock/Results/txt/

For information about the format of these files, refer to the attachment titled How to Monitor the FCC
Auctions On-Line.

If you cannot access the files at the preceding primary location, you can access the same files at ether of
the following secondary locations: wtbwww13.fcc.gov or www.fce.gov/wtb/auctions/.

G. Uningtalling the FCC Mock Bidding Software
To uningal the FCC Mock Bidding Software:

1. Double-click the M ock 80 Bidding Software Uninstall icon in the FCC Remote Bidding
System program group.

To seethe Programslig, click the Start button, highlight Programs, then highlight FCC Remote
Bidding System.

2. When the Remove Shared Files? didog box appears, click NO to All, so you preserve files that
are shared with the FCC Remote Bidding Software for Auction 80.

3. When the process has completed, click OK.

Important: If the Mock Bidding Software and the Remote Bidding Software for Auction 80 are
both ingtdled on your compuiter, it is very important that you click NO to All when the FCC
Mock Bidding Software Uningtd| program displays the Remove Shared Files? didog box.
Otherwise, the uningtal will delete shared program files and you will need to re-ingtdl the Remaote
Bidding Software for Auction 80.

H. Help

For technicd assstance with ingtaling or using FCC software, contact the FCC Technica Support
Hotline a (202) 414-1250 (V) or (202) 414-1255 (TTY). The FCC Technical Support Hotlineis
generdly available Monday through Friday from 7 am. to 10 p.m. ET, Saturday from 8 am. to 7 p.m.
ET, and Sunday from 12 p.m. to 6 p.m. ET. All callsto the FCC Technical Support Hotline are
recorded.
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I.  ATTACHMENT D

HOW TO MONITOR THE FCC AUCTIONS ON-LINE

The auction announcements and round results for Auction 80 will be accessible through the FCC Wide
Area Network, the Internet, and the FCC’ s Automated Round Results System. Y ou can check on
round results and dso read any materid released by the Commission during the course of the auction.
In the sections that follow, Options 1 and 2 list the information needed to track the auction from your
computer; Option 3 lists an dternate method.

Conventions
Theingructionsin this section use the following typographica conventions:

bold Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions link,
Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Location fied, Selected Licenses
area of ascreen).

bolditalic  Represents charactersthat you must type exactly asthey appear in theindructions. For
example, if you are ingructed to type http: //wtbwwwO1.fcc.gov, you should type dl of
the characters shown in bold italic exactly as they are printed.

SMALL CAPS  Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note: Throughout these ingructions, “enter” means to type the gppropriate information and then press
the ENTER key.

A. Option 1: Tracking the Auction via the FCC Wide Area Network

The FCC hasimplemented a Remote Access System that dlows usersto did in directly to the FCC to
view round results, auction announcements, and messages, and to make suggestions to the FCC
regarding the FCC auction process.

1. Minimum Hardwar e and Softwar e Requirements

The following minimum hardware and software is required to use the FCC Remote Access System:

a Hardwar e Requirements

CPU: Intd Pentium
D-1



RAM: 16 MB (more recommended if you have multiple gpplications open)
Modem: 28.8 Kbps Hayes compatible modem or faster (recommend 56.6 Kbps)
Monitor: VGA or above

Mouse or other pointing device

b. Softwar e Requirements

Operating System:  Microsoft Windows 95/98

Point-to-Point Protocol (PPP) Dider: Usethe Dia-Up Networking feature included with Windows
95/98

Web Browser: Netscape® Communicator™ 4.73 isrecommended. However, you can also use
Netscape Communicator 4.5, 4.51, 4.61, 4.7, or 4.72 (Internet web browser software).

Note: To download Netscape Communicator 4.73 free of charge, access the Netscape download
dteat http://home.netscape.com/download/

2. Connecting to the FCC Network

To use the FCC Remote Access System, you must first connect to the FCC Network using Did-Up
Networking.

Did-Up Networking connects to a 900 number telephone service at a charge of $2.30 per minute. The
first minute of connection time to the 900 number serviceis a no charge.

Did-Up Networking establishes a point-to-point connection from your PC to the FCC Network. This
point-to-point connection is not routed through the Internet.

For ingtructions regarding how to connect to the FCC Network using Dia-Up Networking, see the
Accessing the FCC Networ k Using Windows 95/98 attachment.

For technica assstance with ingtaling or usng FCC software, contact the FCC Technica Support
Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY). The FCC Technical Support Hotlineis
generdly available Monday through Friday from 7 am. to 10 p.m. ET, Saturday from 8 am. to 7 p.m.
ET, and Sunday from 12 p.m. to 6 p.m. ET. All callsto the FCC Technical Support Hotline are
recorded.

3. Using the FCC Remote Access System

After you have connected to the FCC Network, start your Netscape Web browser. In your browser’s
Location fidd, enter http://wtbwwwO03.fcc.gov and then click Round Results Viewer, Suggestion
Box, or Announcements

Note: If you cannot access the preceding Site, and you suspect there is a problem with your
Domain Name Server (DNS), refer to Accessing FCC Sites In Case of DNS Problems at the
end of thisdocument. Or you can use the dternate location, http: //wtbwww26.fcc.gov.
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When you have finished, exit your Web browser, then disconnect from the FCC Network.

B. Option 2: Tracking the Auction via the Internet

Y ou may use your Web browser to download announcements and round results from
wtbwwwO1l.fcc.gov —or from either of two secondary locations, wtbwww13.fcc.gov or
www.fcc.gov/wtb/auctions/ -- as described in the following sections.

1. Downloading from wtbwwwO1.fcc.gov or wtbwww13.fcc.gov:

1. Connect to your Internet service provider and start your Web browser.

2. Inthe Location field of the Web browser screen, enter one of the following locations:
http://wtbwwwO1.fcc.gov or wtbwww13.fce.gov

Note: If you cannot access either of the preceding Sites, and you suspect there is a problem
with your Domain Name Server (DNS), refer to Accessing FCC Stes In Case of DNS
Problemsat the end of this document.

3. Click Auction 80.

* For auction announcements, click Announcements.

* Todownload abid import template file, click Announcements, then sdect template.txt.

* For auctionround results, click Results and then dlick the subdirectory for the type of files
you want to use:

mdb - Microsoft Access database filesin zipped form
txt - text files
dbf - dBASE database files

4. Click the file you want to download.

2. Downloading from www.fcc.gov/wtb/auctions/:

1. Connect to your Internet service provider and start your Web browser.

2. Inthe Location field of the Web browser screen, enter the following location:
http://www.fcc.goviwtb/auctions/

3. Do thefollowing:

a. Inthe Auctions section on theright, click Blanco Texas Broadcast (#30) under In Progress.
b. Then dick Announcements, Programs, or Results.
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*  For auction announcements, click Announcements.

* Todownload abid import template file, click Announcements, then sdect template.txt.

* For auctionround results, click Results and then click the subdirectory for the type of files
you want to use;

mdb - Microsoft Access database files zipped
txt - text files
dbf - dBASE database files

4. Then click the file you want to download.

3. Announcement Files

The announcement files will use the naming convention aa_xxx.nn, where aa is the auction number,
xxX s the round number and nn is the announcement number. For example, 80_002.07 would
represent an announcement for Auction 80 that was posted during round two and was the seventh
announcement for the auction.

4. Round Results Files

For each round, dBase-compatible database files will be uploaded with the following naming
conventions (where xxx represents the round number):

80 xxxS.DBF contains dl bids submitted in a particular round

80_xxxW.DBF contains al bids withdrawn in a particular round (withdrawals are not permitted
in auction 80)

80_xxxE.DBF contains the maximum digibility and remaining number of waivers for each
bidder

80_xxxH.DBF contains the high bid in a particular round and the minimum accepted bid for the
next round

For those who cannot use the dBase-compatible database files, we will aso upload the ASCII text
(.TXT) verson of these files with the same filenames as above (e.g., 80 xxxS.TXT, 80_xxxE.TXT).

In addition, if you want to use Microsoft Access, we upload the MDB access version of the round
resultsfiles as a zipped file with aname of the form 80 _ xxx.ZIP.

File Formats For adescription of the interna formats of the round resultsfiles, refer to

Round Results File Formatsat the end of this document.

a L ocations of Uploaded Files

The newest round results are uploaded to the Results directory based on type of file format: dbf, mdb
(zip files), and txt.

On the primary location, wtbwwwO1.fcc.gov:
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http://wtbwwwO1.fcc.gov/MMB/CP5/Auction_80/Results/dbf/
http://wtbwwwO1.fcc.gov/ MMB/CPS/Auction_80/Resultsmadb/
http:/tbwwwO1.fcc.gov/ MMB/CPS/Auction_80/Results/txt/

If you cannot access thesefiles at the preceding primary location, you can access the samefiles at either
of the following secondary locations: wtbwww13.fcc.gov or www.fcc.goviwtb/auctions/.

b. Archive Directories

After every 50 rounds, fileswill be moved from the Results directory to archive directories. The
following listings show an example of the directory structure for an auction in round 102. Note that the
results for rounds 101 and 102 would be in the Resultsdirectories.

On the primary location, wtbwwwO1.fcc.gov:

Rounds 1-50 http://wtbwwwO1.fcc.gov/MM B/CP5/Auction_80/Results/dbf/D001_050
Rounds 51-100 http://wtbwwwO1.fcc.gov/IMMB/CPS/Auction_80/Results/dbf/D051_100
Rounds 101-102 http://wtbwwwO1.fcc.gov/MMB/CP5/Auction_80/Results/dbf/

Rounds 1-50 http://wtbwwwO0L1.fcc.gov/MMB/CP5/Auction_80/Resultsmdb/M001_050
Rounds 51-100 http://wtbwwwO0L1.fcc.gov/MMB/CP5/Auction_80/Resultsmdb/M051_100
Rounds 101-102 http://wtbwwwO1.fcc.gov/IMMB/CP5/Auction_80/Results/mdb/

Rounds 1-50 http://wtbwwwO01.fcc.gov/IMMB/CP5/Auction_80/Results/txt/TO01_050
Rounds 51-100 http://wtbwwwO1.fcc.gov/IMMB/CP5/Auction_80/Results/txt/TO51_100
Rounds 101-102 http://wtbwwwO1.fcc.gov/MMB/CP5/Auction_80/Resultg/txt/

If you cannot access the files at the preceding primary location, you can access the same files at ether of
the following secondary locations: wtbwww13.fcc.gov or www.fce.gov/wtb/auctions/.

C. Option 3: Tracking the Auction via the FCC’s Automated Round Results System

Round results are a so available from a touch-tone phone, using the FCC's Automated Round Results
System. To access this system, dia 800-432-2110 from outside the Washington DC area and 202-
414-1260 from within the Washington DC area. Once the system has been activated, you will follow
the voice prompts. Y ou will need to know the auction number (80, in this case) and the round number.

D. Accessing FCC SitesIn Case of DNS Problems

When you enter a URL into your browser, the system must convert this dphanumeric text (eg.,
www.fcc.gov/wtb/auctions/) into its associated numeric |P address (192.104.54.3, inthiscase). To
make this conversion, the system checks URL-to-1P-address “lookup” tables in two different places.

Fird, it looks a the table contained in afile caled hosts in the c:\windows directory on your computer’s
hard drive. If the URL isnot in that table, the system looks in the database on your Domain Name
Server (DNS). However, if your DNS is unavailable for some reason, the system will not be able to
find the IP address you requested.

D-5



The following procedure is intended to help ensure that you can access auction results files on the
FCC sWeb and FTP dtesif your designated DNS has problems. Note the following:

The IP addresses shown in the following procedure are correct as of the date this document
was created. They may have changed subsequently. In case of problems, please check with
Tech Support at (202) 414-1250.

Make entries in the hosts file only to work around DNS problems. We do not recommend
leaving these entries in permanently; please remove them when your DNS problem has been
resolved.

To add FCC-related URL entries to your computer’ s hodsfile, do the following:

1. Usng Windows Explorer, ensure that the hogts file exists in your c:\windows directory. If
c:\windows has no hosts file, use the Windows Rename function to change the name of the
hosts.sam fileto hosts (with no extenson).

To do this, use your right-hand mouse button to click the hosts.sam file, then dlick the Rename
option in the menu that appears.

2. Using atext editor of your choice, such as Wordpad or Notepad, open the hosts file in your
c:\windows directory.

Thisfilewill dready contain the following entry:

127.0.0.1 localhost
3. Usgng the same format (with at least one space between each number and its corresponding URL),
add the following entries to the bottom of the file:

192.104.54.3  ftp.fcc.gov
192.104.54.3  www.fcc.gov
208.245.40.194 witbftp02.fcc.gov
208.245.40.194 wtbwwwO1.fcc.gov
207.123.193.68 witbftpOl.fcc.gov
207.123.193.68 wtbwwwO01.fcc.gov

4. Savethefile and exit your text editor.
Be sure that the file name has not changed to hosts.txt or hosts.doc or amilar. It must remain just

hosts (with no extenson).

E. Round Results File For mats

This section describes the formats for the round results files that will be uploaded to the FCC Internet
gte after each round of the auction. Thesefilesarein dbf and txt format and contain the raw output of
the auction data
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The round results files were used by the previous Excel based tracking tool produced by the FCC and
are dill being digtributed for those bidders who use them for their own tracking purposes. The following
layouts are for the dbf files. The txt fileswill have character field types.

1. ALL BIDSfile
MX_group char(6)
freq_block char(2)
round_num numeric
bid amt numeric
bidder num numeric
fcc_acct char(10)
date char(10)
time char(14)
net_bid amt numeric
sort col 1 numeric
sort_col 2 numeric
sub_market numeric

2. HIGH_BIDSfile
MX_group char(6)
freq_block char(2)
bid round numeric
bid amt numeric
bidder num numeric
fcc_acct char(10)
date char(10)
time char(14)
net_bid amt numeric
min_accept numeric
num_of _bids numeric
sort col 1 numeric
sort_col 2 numeric
sub_market numeric

3. MAXIMUM_ELIGIBILITY file
round_num numeric
bidder_num numeric
fcc_acct char(10)
max_dlig numeric
rmng_waivr numeric
wavr_ind char(1)
rmng_withdrawas numeric
required act numeric

current_activity numeric



MX_group
freq_block
bid round
bid amt
bidder num
fcc_acct
date

time

net_bid amt
sort_col_1
sort_col 2
sub_market

bidder_ num
fcc_acct
CO_name

bidding_credit_pctg

short_name
bidder num
F.

For technica assstance with ingtaling or usng FCC software, contact the FCC Technica Support
Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY). The FCC Technical Support Hotlineis
generdly available Monday through Friday from 7 am. to 10 p.m. ET, Saturday from 8 am. to 7 p.m.
ET, and Sunday from 12 p.m. to 6 p.m. ET. All callsto the FCC Technical Support Hotline are

recorded.

WITHDRAWAL Sfile

char(6)

char(2)

numeric
numeric
numeric
char(10)
char(10)
char(14)
numeric
numeric
numeric
numeric

BIDDER_CROSS REFERENCE file

numeric
char(10)
char(50)
numeric
char(10)
numeric
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I. ATTACHMENTE

ACCESSING THE FCC NETWORK
USING WINDOWS 95/98

This attachment describes how to access the FCC Network from a system that is running the Microsoft
Windows 95 or Microsoft Windows 98 operating syslem. This involves configuring did-up network
access and then performing the dia-up procedure.

This attachment describes two methods to establish a remote connection to the FCC Network for both
the Mock Auction and Auction 80:

The section titled Quick-Start Method for Connecting to the FCC Network describes a quick-start
approach, which uses stlandard default values to configure the did-up networking software.

If you need something other than the standard defaullts, you can use the more complete method for

configuring and starting the did-up software that is described under Complete Method for
Connecting to the FCC Network.

This atachment dso provides sections describing Troubleshooting and Help.

Conventions
Theingructionsin this section use the following typographica conventions.
bold Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions link,

Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Applicant field, Selected Licenses
area of ascreen).

bolditalic  Represents characters that you must type exactly asthey appear inthe  ingtructions.
For example, if you are instructed to type http://wtbwwwO3.fcc.gov, you should type
al of the characters shown in bold italic exactly asthey are printed.

SMALL CAPS  Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note: Throughout these indructions, “enter” means to type the gppropriate information and then press
the ENTER key.



A. Quick-Start Method for Connecting to the FCC Network

Following are quick-start procedures to establish a remote connection to the FCC Network for both
the Mock Auction and Auction 80.

Important: Disable any screen saver software before performing either of the following
procedures.

1. Quick-Start for Mock Auction

To establish aremote connection to the FCC Network, double-click the Mock 80 Dial-Up
Connection icon and then select Connect. Alternatively, you may do the following:

1.

2.

6.

Click the Windows 95/98 Start button.

Click the Programs option.

On the Programs menu, click the FCC Remote Bidding Softwar e option.

Click Mock 80 Dial-Up Connection.

The system checks to ensure that your computer has al components necessary to establish adia-up
connection. If arequired component is missing, the system invokes Windows to help you set up the
component.

When the system has verified that all necessary components are present, adialog appears with
ingructions on how to establish the did-up connection. Read these ingtructions, then click the OK
button.

When the diad-up connection window agppears, click Connect to connect to the FCC Network.

Note that the system has aso placed an icon labeled M ock 80 Dial-Up Connection on your desktop.
To establish adid-up connection in the future, you can double-click thisicon instead of performing the
preceding steps.

2. Quick-Start for FCC Auction 80

Note: If you connect to the FCC’ s 900# telephone service, there is a charge of $2.30 per
minute. The firg minute of connection time to the 900 number serviceis a no charge.

To establish aremote connection to the FCC Network, double-click the Auction 80 Dial-Up
Connection icon and then select Connect. Alternatively, you may do the following:

1.

2.

Click the Windows 95/98 Start button.

Click the Programs option.



6.

On the Programs menu, click the FCC Remote Bidding Softwar e option.

Click Auction 80 Dial-Up Connection.

The system checks to ensure that your computer has al components necessary to establish adia-up
connection. If arequired component is missing, the system invokes Windows to help you set up the
component.

When the system has verified that al necessary components are present, a dialog appears with
ingructions on how to establish the did-up connection. Reed these ingtructions, then click the OK
button.

When the diad-up connection window agppears, click Connect to connect to the FCC Network.

Note that the system has aso placed an icon labeled Auction 80 Dial-Up Connection on your
desktop. To establish adid-up connection in the future, you can double-click thisicon instead of
performing the preceding steps.

3. If You Have Trouble Establishing the Connection

If you are have trouble making the connection, two things may have to be changed:

The connection automaticaly precedes the phone number that isto be dided with 9. If you need a
digit other than 9 to reach an outside line, or no digit is needed, you will need to change the settings
in the connection.

To make this change, double-click the connection icon, then click Dial Properties. You will see
that 9 precedes the phone numbers on dl cals, both local and long-distance. Change this digit to
what you need to get an outside line, or delete the 9, if appropriate. Then click OK.

The connection is set up for astandard 56K modem. If you are using some other kind of modem,
you must change this setting.

To access did-up networking:
1. Click the Windows 95/98 Start button.
2. Click the Programs option.
3. Onthe Programs menu, click the Accessories option.

4. InWindows 95, click Dial-Up Networking. InWindows 98, click Communications,
then Dial-Up Networking.



5. When you seetheicon for did-up networking that was created for you, right-click it and
select Properties.

You will bein the Generd tab and you will see the sandard default modem sdlected.

6. Sdect your modem from the drop-down menu and then click OK.

B. Complete Method for Connecting to the FCC Network

This section describes how to configure both the FCC Mock Bidding Software and the FCC Remote
Bidding Software for did-up networking. Then it describes how to use the configured software to
establish a connection to the FCC Network.

1. Configuring Dial-Up Networking
Important: Disable any screen saver software before performing the following procedure.
To gart did-up networking:

Click the Windows 95/98 Start button.

Click the Programs option to display the Programs menu.

Click the Accessor ies option to display the Accessories menu.

In Windows 95, click Dial-Up Networking.

In Windows 98, click Communications, then Dial-Up Networking.

oo o

If Did-Up Networking is not an option on your Accessories menu, you should ingal it from
your Windows 95/98 CD or diskettes.

When the Did-Up Networking window appears, double-click the M ake New Connection
icon.

The Make New Connection window appears.

If you are connecting to the FCC Network during the Mock Auction, type FCC Auctions
800# in thefidd titled Type a name for the computer you are dialing.

If you are connecting to test your connection on the 900# that will be used during Auction 80,
type FCC Auctions 900# in thefidd titled Type a name for the computer you are dialing.

Note: If you connect to the FCC's 900# telephone service, there is a charge of $2.30
per minute. Thefirg minute of connection time to the 900 number serviceisa no
charge.

In Windows 95, click the down arrow at the right of the Select a modem field and select your
modem from the menu of available modems.
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10.

11.

12.

13.

14.

In Windows 98, click the down arrow at the right of the Select a device fidd and sdlect your
modem from the menu of available devices.

If your modem does not appear on thisligt, you must ingal your modem driver according to the
modem manufacturer inga lation procedures, which are usudly described in your modem'’ s user
manud.

Click the Next button.

If you are connecting to the FCC Network during the Mock Auction, type 800 and 378-7435
inthe Area Code and Telephone Number fields, respectively.

If you wish to test your connection on the 900# that will be used during Auction 80, type 900
and 555-5335 in the Area Code and Telephone Number fields, respectively.

Verify that the correct country is selected in the Country code fidd.

If necessary, click the down arrow at the right of the Country code fidd and sdlect the
appropriate country from the menu of available countries.

Click the Next button.
Click the Finish button.

Anicon labeled ether FCC Auctions 800# or FCC Auctions 900# appearsin the Did-Up
Networking window.

Verify that properties are configured correctly before attempting a did- up sesson. Put the
mouse pointer on the FCC Auctionsicon that you wish to configure and click the right mouse
button to digolay amenu. Click Proper ties from the menu.

Click the Configure button. Click the Options tab at the top of the Properties window.

In the Connection control area of the Options tab, verify that neither option is selected. If
either option is sdlected, click the check box at the left of the option to desdlect it. Then click
OK.

In Windows 95, click the Server Type... button.

In Windows 98, click the Server Typestab at the top of the Properties window.

In the Advanced Options area, verify that only Enable software compression is selected.

If it is not sdlected, click the check box at the left of the option to sdlect it. If either of the other
optionsis selected, click the check box to desdlect it.
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15.

16.

17.

18.

19.

20.

In the Allowed Network Protocols areg, verify that only TCP/IP is selected.

If it isnot sdlected, click the check box at the left of the option to select it. If either of the other

options is selected, click the check box to desdect it.
Click the TCP/IP Settings button and sdlect Specify name server addresses.

Type 165.135.241.149 as the Primary DNS and 165.135.79.95 as the Secondary DNS.

At the bottom of the TCP/IP Settings window, ensure that Use |P Header Compression and

Use Default Gateway on the Remote Network options are selected.
Click OK on the TCP/IP Settings window and the Server Type window.

a Click the Windows 95/98 Start button, then click the Settings option to display
the Settings menu.

b. Click Control Pand and then double-click the Network icon.

c. Highlight the TCP/IP Protocol and click Properties. If there are multiple TCP/IP
protocols, highlight TCP/IP --> Dial-Up Adapter and click Properties.

d. Click the DNS Configuration tab.

e. Typebidder intheHost box and type fcc.gov in the Domain box.

Note: You arelimited to three DNS entries. If you aready have three DNS entries, you
must delete two of them before performing the next two steps. To do this, click thefirst
entry you want to delete and click the Remove button. Then click the second entry you
want to delete and click the Remove button again.

f. Type165.135.241.149 in the DNS Server Search Order box and click the Add button.
g Type165.135.79.95 in the DNS Server Search Order box and click Add again.

h. Click OK on the TCP/IP Properties windows, then click OK on the Network
windows.

If you are prompted to restart your computer, click Y es to restart, then begin
the Dial-Up Procedure.

2. Dial-Up Procedure

If the Dia-Up Networking window is not currently open, do the following:

a. Click the Windows 95/98 Start button.
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b. Click the Programs option to display the Programs menu.

Click the Accessor ies option to display the Accessories menu.

In Windows 95, click Dial-Up Networking

In Windows 98, click Communications, then Dial-Up Networking.

oo

The Dia-Up Networking window appears.
In the Did-Up Networking window:

Double-click the FCC Auctions 800# icon if you wish to connect to the FCC Network during
the Mock Auction.

Double-click on the FCC Auctions 900# icon if you wish to test your connection to the 900#
that will be used during Auction 80.

Note: If you connect to the FCC's 900 number telephone service, there is a charge of $2.30
per minute. The first minute of connection time to the 900 number service is a no charge.

Click the Connect button on the window. Do not enter User name or Password.

The Connection window appears, indicating the status of your connection as your modem dias
into the system. Thiswindow must remain running during your dia-up sesson. Y ou may
minimize the window, if you wish.

If your modem fails to establish a connection, please see the Troubleshooting section below.

Once the connection is established, double-click the Auction 80 M ock Auction Software or
Auction 80 Bidding Softwar e icon.

When you have finished, exit the mock or auction software, then click the Disconnect button
on the Connection window to end your did-up sesson.

C. Removingthe Dial-Up Networking Service

Once you have finished using the dia-up networking service, you can remove it from your computer, as
follows

1.

2.

Click the Windows 95/98 Start button, then click the Settings option to display the Settings menu.
Click Control Pand and then double-click the Network icon.

Highlight the TCP/IP Protocol and click Properties. If there are multiple TCP/IP protocals,
highlight TCP/IP --> Dial-Up Adapter and click Properties.

In aWindows 98 environment, a confirmation didog gppears. Read the information on the didog,
then click the OK button.



4. Click the DNS Configuration tab.

5. Click the DNS Server Search Order box containing 165.135.241.149 to sdect it, then click the
Remove button.

6. Similarly, click the DNS Server Search Order box containing 165.135.79.95 to sdlect it, then click
the Remove button.

7. Click OK on the TCP/IP Properties windows, then click OK on the Network windows.
8. If you are prompted to restart your computer, click Y esto restart.
9. Removethe FCC Auctions 800# icon from your desktop. That is, click the icon with your right

mouse button and then click the Delete option in the pull-down menu.

D. Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating them.

1. Modem does not respond

1. Confirm that all physica connections for the modem are present.

2. Confirm that the phone line is active by connecting it to a telephone and checking for adid tore.

3. If you are diding the 900 number service, check for a 900 number telephone block. If the
volume sttings are low, the modem may be diding but not connecting. Check for this by trying
to connect to the 800 number, or by diding the 900 number on that line using a telephone.

4, Confirm that the correct modem driver isingaled for your modem.

2. Modem dials but does not connect

1 If you are diaing the 900 number service, check for a 900 number telephone block. Check for
this by diding the 800 number to see if you connect, or by diaing the 900 number on thet line
using atelephone.

2. Confirm that the number the modem is diding is correct.

3. Confirm that the modem prefix, if any, is correct.



3. Modem dials and connects, but nothing appears when you enter the Location in the
Web browser

1.  Veify the Did-Up Networking settings specified in the Configuring Dial-Up Networking
Section.

2. Confirm that your Web browser is not using proxies.

a) On your browser, click the Prefer ences option in the Edit menu.
b) Inthe Category areaat the left, double-click Advanced.

c) Click the Advanced structure’ s Proxies option.

d) Click theradio button labeled Direct connection to the I nternet.
e) Click the OK button at the bottom of the window.

4. Receive an Internal Server error in the Web browser

1. Confirm that the Location is correct.

2. Confirm that Java and JavaScript are enabled in your Web browser, and confirm that Cookies is
set to Accept All.

E. Help

For technicd assstance with ingtalling or using FCC software, contact the FCC Technica Support
Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY). The FCC Technical Support Hotlineis
generdly available Monday through Friday from 7 am. to 10 p.m. ET, Saturday from 8 am. to 7 p.m.
ET, and Sunday from 12 p.m. to 6 p.m. ET. All callsto the FCC Technical Support Hotline are
recorded.



